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THE EXERCISE BOOK

PART 1 : HOW TO CREATE A PENCIL
Let’s begin by creating something rather simple like a pencil. It is an interesting object so, let us begin.

1. Hit «4» on the number pad to rotate the scene to the following view.

N
NN
»
11

2. Select the 2D Drawing tool from the Construction toolbox which is already displayed on the screen.

m Then select the circle.
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Click on the vertical axis 10cm above the table to locate the center of the
circle.

Drag the mouse on the horizontal axis 2cm to
the right and click to fix the radius.
Hit Return and put aside the tool by sweeping
j the cursor off the right side of the screen.

. : You’ve just created a circle with a radius of

2cm and made of 8 points
/ \ which is the number by default.

3. Now hit «2» on the number pad to return to the front view.
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4. Hold the Control key and hit the Left Arrow key about four times to pan the view and in order to have enough
space to create the body of the pencil.
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5. Select the Extrusion tool from the Construction toolbox and then click on the circle that you have just
made.

Hit the space bar once, this will allow you to lock onto the horizontal axis. Drag the mouse about
50cm to the left, click again and hit Return.

You can check the distance by looking at the XYZ data box in the lower left corner of the

screen.



You will see that both ends of the body are outlined in red. If you click on
AT—————————=\ one end, the red colour disappears and
he object becomes capped.
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6. Since we only want to cap one end, click only on the right hand side of
the object, then put the tool aside.
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7. The body of the pencil is now created. We have to zoom in on the left part before going on to build the rest of
the pencil. Drag the cursor off the bottom of the screen and the Control Panel appears.

ESelect the Zoom Window tool.

Click the location that is to serve as the center of the zoom.

Move the cursor to expand the zoom box and
click.

" 8. Now that you have zoomed in on the left
end of the pencil body, hit the Left Arrow key in order to rotate the view slightly as shown in the images below.

9. Now, click twice on the right button of the mouse (Option-click for Mac users), the first click changes the Wand
into the Lasso, the second click changes the Lasso into the Bull’s-eye cursor.
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Select the four following points: the top, the right, the bottom and the left. Put the cursor aside
when you have finished.

.10. Drag the wand off the bottom of the screen and the Control Panel appears.

Select the Zoom Extend tool from the Control Panel to move the drawing back into space.
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d 11. Now, move the mouse to the right side of the screen and change the toolbox into the Modeling tool-
box and then select the Stretch tool.

I Hit the space bar once in order to lock onto the horizontal axis.

Then click on one selected point and drag the mouse 3cm to the left. Click
/Ei again to fix the displacement and put-aside the tool.
i
AR You can check on the distance by looking at the XYZ data box.
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12. Finally click with the Wand on the left hand side so that the four points
are no longer selected.
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m 13. Now go back to the Construction toolbox by putting the wand aside twice and select the Curve
Extraction tool. The cursor then becomes a Lasso.

Surround the entire left end of the pencil body and then hit Return. Put the tool
S —=  aside.
| —\
You should obtain a separate closed polyline as the currently selected object.

14. Choose the 2D Drawing tool
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To obtain a concentric circle, click on the geometrical center of the extracted curve to fix the
two axes.
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Then change the viewpoint as shown using «4» on the number pad.

15. Select the Circle from the 2D Drawing palette

Click on the intersection of the axes to locate the center of your circle.

Then drag the mouse 1cm to the right and click again. Hit Return and put the
tool aside.

16. Hit «2» on the number pad to go to the front view.
Move your work back in space by hitting the decimal point on the number pad. This is a reverse zoom shortcut.

Make some space on the left side of the object by panning the view (Hold the Control key and hit the Left Arrow
key about four times )

E / The circle is now the currently selected object.

17. Sweep wand twice off the right side of the screen in order to switch from the Construction to the Assembly
toolbox.

“¥ Select the Move tool from the Assembly toolbox and click on the circle.
Hit the space bar to lock on the horizontal axis.

Move the circle about 6¢cm to the left of the pencil body and then click
— ____again. Put the tool aside.
I ! |
You can check on the distance by looking at the XYZ data box.
18. Now you need to zoom in once more, so move the mouse to the bottom of the screen to make the Control
Panel appear.

_‘J Select the Zoom Window tool.

Click on the location that is to serve as the center of the zoom. Then move the cursor to expand the zoom box




and click.

Surround the area, as shown in the diagrams.

19. Now sweep the cursor off the right side of the screen to display the Construction toolbox.

\B Select the Ruled Surface tool. We are going to create a surface using the small circle and the extrac-
ted polyline. With the Bull’s-Eye cursor, first click on the top point of the extracted polyline, then click on the top
point of the small circle.
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As soon as you click the second point, a patched surface is created between the two curves for-
ming the sharpened part of the pencil.

Put the Ruled Surface Tool aside.

After the use of the Ruled Surface tool, both curves become hidden.

20. Now we are going to create the last part of the pencil which is the lead point. Drag the wand off the bottom
of the screen to make The Control Panel appear.

“S Select the Show tool to unmask the small circle. When you select this tool you will see that the two
curves are displayed on an empty screen.
Clicking on the circle with the white phantom turns the circle white. Then put the tool
aside.



The small circle then becomes the current object.
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21. Now select the Extraction tool again.

Click on the small circle and drag the cursor
5cm to the left so that you obtain a pointed
form. Click again and validate by pressing Return and put the tool aside.

22. Drag the cursor off the bottom of the screen once more to make the Control Panel appear.
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Select the Zoom Extend tool to zoom away from your work in order to view the entire design.

23. Drag the cursor again off the bottom of the screen and the Control Panel reappears.

ﬁ Select the Fast Shade tool (i.e the bucket icon) and hit Return. Each part of the pencil is then shaded with a
different solid color.

With this exercise you have seen a very small part of the Amapi’s possibilities, which are infinite. Let’s now go
to the following pages where we are going to create other objects ...



PART 2 : HOW TO CREATE AN INDUSTRIAL OBJECT

This time, we are going to create a simple industrial object.

1. Hit «2» on the number pad to rotate the scene to the front view.

I 2. Select the Cube tool from the Construction toolbox that is already displayed on the screen. Create a
cube, the size of it is up to you, let’s say 20cm.

The axes automatically snap to the center of the workbench.

%Click on the intersection and the vertical axis disappears.
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Drag the wand about 20cm to the right and then click again.

You can check on the distance by looking at the data box displayed in the lower left corner of
the screen.
The tool is automatically released after you click for the second time.

. Select the Curve Extract tool from the Construction toolbox still displayed on the screen.



Surround with the Lasso the top portion of the cube, then hit Return. Put the tool aside.
In this way you obtain a separate curve which will be used later to create a new top surface
for the cube. This curve is now the current object (its geometrical center is displayed).

4. Now select the 2D Drawing palette from the Construction toolbox.

First click on the geometrical center to select it as the center of the axes. Then hit «5» on the
number pad to show the top view of the object.

T Select the Circle Tool and click on the geometrical center in order to locate the center of
(B)ersbeen b yoUI cCircle.

+ Then drag the mouse to the right and click again to fix a radius of approximately 5cm. Hit
Return and put the tool aside.

You can check on the radius by looking at the data box displayed in the lower left corner
of the screen.
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6 5. Now select the Ruled surface tool from the Construction toolbox to create a
surface between the square of the box top and the circle.
Click with the Bull’s-eye on the right top corner of the cube, then on the point of the circle that is located on the
diagonal of the cube.
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As soon as the second point is selected the surface is created.

Put the tool aside.




If you make a mistake, you can always undo the previous steps of your work by selecting the
Undo command from the Edit menu.

6. Without changing the view, drag the cursor off the bottom of the screen to bring up the Control Panel.

“ Select the Show tool. The two curves that were hidden by the use of the previous tool are now dis-
played on a black screen.
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7 . Hit «2» on the number pad to go back to the front view of the object.

Clicking on the circle with the white phantom turns the circle white. Then put the tool aside.

The circle is now the current object.

4‘} 8. Select the Extrusion tool from the Construction toolbox.

Click on the circle and then hit the space bar twice to lock onto the vertical
axis.

Drag the cursor about 10cm upwards
then click again. Hit Return to finalize
the extrusion.

The Cap tool appears in the upper left corner of the screen. You can cap the top of the cylinder
which is outlined in red by cliking on it with the Wand or you can immediatly put the Cap tool aside.

9. Now you should have three entities in the scene that are displayed by different colours. Sweep
the cursor twice off the right side of the screen to select the Assembly toolbox.

Choose the Welding tool.



Surround a small portion of each section to be welded with the lasso then hit Return.
The sections are now united as a single object.

10. Hit the upper Arrow key two or three times to slightly change the view of the object.

11. Then drag the cursor twice off the right side of the screen to display the Modeling toolbox.

Y
Select the Filleting tool.

\ & Click on the right button of the mouse (Option click for MAC users) to get the lasso.
~

Now select the lower portion of the cylinder

by surrounding the circle in the middle of
ﬁ the cubes upper surface without touching
—— —\ the points on the cube itself. Then hit
Return.

A filleted surface appears on a part of the
the cylinder’s base.

Use the «+» and «» Keys on the keyboard to increase or decrease the radius of the fillet .
With this tool you can see how the radius changes in real time. When the desired radius is
reached, hit Return.

A filleted surface is created all around the base of the cylinder.




Your industrial object is now finished. You can drag the cursor off the bottom of the
screen to display the Control Panel. Select the paint bucket and hit Return to fast
shade the object. You can also turn your work around using the Arrow keys to see
it from different views.

PART 3 : HOW TO DESIGN A BOTTLE OF PERFUME
Now let’s do something that is more chic!

1. Hit «<2» on the number pad to rotate the scene to the front view.

' 2. Select the Cube tool from the Construction toolbox that is already displayed on the screen.
The axes automatically snap to the center of the workbench.

Click on the intersection.

Q The vertical axis disappears.

Drag the cursor to the right then click again.



The cube may be of any size. It just needs to be located on the table and not above.
The tool is automatically released after you click for the second time.

3. Drag the cursor off the right side of the screen to display the Modeling toolbox.

- Select the Single Axis Scale. A data box appears in the lower left corner of the screen displaying the
dimensions of the cube. Modify them as follows:

- Hit Tabulation, type «11,5» for X.

- Hit Tabulation, type «1,5» for V.

- Hit Tabulation, type «11,5» for Z.

- Finally, hit Return and put the tool aside.

— Whatever the original size of your cube was, this is what you should now have. It is the base
for your bottle of perfume.

4.Drag the cursor off the bottom of the screen to display the Control Panel.

I r | Select the Perspective tool to change the view.

— |

This makes the following tool easier to use.

o

m 5. Go back to the Construction Toolbox by sweeping the cursor

twice off the right side of the screen and select the Curve Extraction tool. If necessary, zoom in on your work by hit-
ting the «3» keythree or four times on the number pad.

ﬁ Surround the top portion of the cube with the Lasso, then hit Return. Put the tool
aside.

- 6. Go back to the Control Panel by dragging the cursor off the bottom of the screen and select

the Perspective tool again to return to the original view.

5 The curve defining the top face is now the currently selected object (its geometrical cen-

| —— ter is displayed).

7. Hit «5» on the number pad to rotate to the top view of the object.



8. Drag the cursor off the right side of the screen to display the Modeling toolbox.

' Select the Fillet tool. Use the «+» Key on the keyboard to increase the radius of the fillet to approxima-
tely 1,6¢cm then hit Return.

- ~
Check the radius of the fillet by the data box in
the lower left corner of the screen.

= b = Then hit «2» on the num-

ber pad to return to the front view. / \

9. Select the «Define catalog...» command from the File menu. Double-click on the «Amapi 2.0 folder» then click
on «Samples» and finally click on the «Current» button.
The dialog box is dismissed and the files contained in the «Samples» folder will now be dis-
played in the Catalog. You are going to use one of these files to create the body of the perfume
bottle.

Now select the Catalog which is accessible from any toolbox.
Click on the 8th icon containing the file called «profile» and then click anywhere in the

The curve automatically snaps onto the base of the bottle of perfume, since it was there
that it was previously created.

Put aside the cursor to get out of the Catalog.

10. Sweep the cursor twice off the right side of the screen to return to the Construction toolbox.

Select the Extrusion tool and then click on the profile.

This surface is automatically generated as soon as you click on the profile.

The Cap tool appears which allows you to close the top and bottom of
the form created.

Put it aside, do not use it at this time.




77 Now hit»2» on the number pad to rotate the object to the front view.

11. Drag the cursor off the bottom of the screen to display the Control Panel.

| Select the Zoom Extend tool to move your work back into space.

12. Go back to the Control Panel.

| r | I Select the Perspective tool to change the view.

\ [/
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W 3/ This makes the following tool easier to use.
1
& 13. Select the Curve Extract tool.
Surround the top of the form with the Lasso and then hit Return. Put
/\ﬁg @ 55y the tool aside.
\ /
\ 7] \\\\ ——
7 T 77 The extracted top curve is now the currently selected object.

14. Display the Control Panel by dragging the cursor off the bottom of the screen.

| r | I Select the Perspective tool again to return to the original view.

15. Select the 2D Drawing palette from the Construction toolbox.
Click on the geometrical center of the selected curve in order to designate it as the loca-
tion of the XY axes.

Then hit «5» on the number pad to display the top view of your work.

Now select the Circle tool click once more on the center of the axes.
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Drag the cursor to the upper right to get a radius of 4,25cm .

> - - Make sure that the cursor is displaced equally in the X and Z directions in order to
i obtain a circle that is
- correctly orientated.

C Click again and the slider +/- appears.

16. Now in order to fix a number of 20 points for the created circle, either use the «+» key on the number pad to
increase this number, which is 8 by default or hit Tabulation and type 20, then hit Return to validate. Put the tool

aside.
@ @ The circle is now the currently selected object.

17. Hit «2» on the number pad to

return to the front view.

18. Drag the cursor off the right side of the screen twice to display the Assembly toolbox.

PO
=" Select the Move tool from the Assembly toolbox and click on the circle.
Hit the space bar twice to lock onto the vertical axis. Then move the circle about 2cm upwards,

I click again and put the tool aside.




19. Return to the top view by hitting «5» on the number pad. Then hit «,» on the same
@ number pad two or three times in order to zoom away from your work a little bit.

20. Now drag the cursor off the right side of the screen to display the Construction toolbox.

\3 Select the Ruled Surface tool to create a ruled surface between the circle and the extracted square.
Make sure that you click on the points shown below (i.e first on the lower right point of the circle then on the lower

left point of the lower right corner of the extracted square).

As soon as you click on the second point, a surface is generated bet-

ween the circle and the extracted square. The two curves are then hid-
den.

Put the tool aside.

21. Now drag the cursor off the bottom of the screen to display the
Control Panel.

“S Select the Show tool.

Both hidden curves appear on a black empty screen.

Clicking on the circle with the white phantom. It turns white.
Put the tool aside.

The circle is now unhidden and is the currently selected object.

Hit «2» on the number pad to see the created surface from the front view.
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7. You are now going to shape the neck of your perfume bottle. First you have to zoom into the top portion of the
bottle. Drag the cursor off the bottom of the screen to make the Control Panel appear.

Then drag the cursor 1cm upwards and 5¢m to the right and click again.

¥ Then drag it 1cm upwards and 4cm to the left and click
s again.

Hit Return to finalize the extrusion and put the tool
=aside.

Your bottle neck is now shaped.

23. Return to the Control Panel.

L| Select the Zoom Extend tool in order to view your entire design.

Return once more to the Control Panel to select the Perspective tool.
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3 This view will make the use of the next tools more easy.

w 24. Now you are going to use a cap for your perfume bottle that

was already been created and saved in the Catalog.

To find this file, select the Catalog which is accessible from any toolbox.
The folder called «Samples» is still the current folder.
Click on the box containing the file called «Cap» then click anywhere in the scene.

The cap appears directly above the neck of your bottle.

Put the wand aside to leave the Catalog.

(<] _ . :
P —— 25. Click on the cap with the Wand to select it as the current
= = object.

26. Drag the cursor twice off the right side of the screen to display the Assembly toolbox.

Select the Snap tool in order to place the cap on the neck of the perfume bottle.
Hit the space bar twice to lock onto the vertical axis.
First click a point on the bottom of the cap and then click on a point on the top end of the
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The cap snaps onto the neck as soon as you click on the second point.

\aW ryy Put the tool aside.
NN 777
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27. Now select the Welding tool from the Assembly toolbox.



Surround the area shown in the picture with the Lasso and then hit Return.
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Both parts of the body are now welded together to form a new objectt with its geo-
metrical center displayed.
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28. Now drag the cursor twice off the right side of the screen to display the Modeling toolbox.

‘ Select the Smooth tool.

A smoothed surface appears on a part of the body of the object.

w Click once on the right button of the mouse (Option-click for Mac users) and the

Wand changes into the Lasso.

Surround the area shown in the picture with the Lasso (the top edge of

/ AN
l |\ /| | the body) in order to keep it sharp.
D Y
= - = Then hit Return to validate your selection.
\\ [/
WL 1
\Q; FL// Click on the surface in red with the Wand. A smoothed surface now
appears over the entire body of the object and you can see at the time-

that the selected edge remains sharp.

Hit return a second time to finalize the surface and to quit the Smooth tool.

29. Drag the cursor off the bottom of the screen to make the Control Panel
appear.

g 1

Select the Perspective tool again.




Now you see that, the bottle of perfume is finished.

By using the arrow keys you can turn your work around to see it
from different views.

To save it, simply select the Catalog from
any toolbox and click on an empty box.
Type a name and hit Return.

You can change the Catalog folder in which you save this file

using the Define Catalog command from the File menu. If you don’t, it will be saved in the cur-
rent folder, which is the «<Samples» folder.




